ANEXO B
MANEJO DEL SIMULADOR NCTUns 3.0

En este documento se examinaran asuntos concernientes a la instalacion y uso de la
herramienta de simulacién NCTUns (National Chiao Tung University Network Simulator),
creada por el profesor Shie-Yuan Wang. Se expondran los recursos hardware y software
necesarios para ello y, para facilitar su comprension, se explicara su modo de uso a
través de un ejemplo.

Debido a que NCTUns se basa en una metodologia de simulacién de reingreso de kernel
y que sélo funciona en sistemas Linux, no todos los sistemas operativos de Unix cumplen
con los requisitos necesarios para ello, por lo que su creador recomienda sistemas
creados por Debian y Red Hat, en especial Red Hat Fedora Core 4.0 con kernel 2.6.11
[1]. Una vez instalado este sistema operativo se deben instalar los paquetes de G++ y
deshabilitar el archivo SELinux.

En cuanto a los requerimientos hardware, se recomienda, como recursos minimos, un
procesador de 1.6 GHz de 32 bits, 512 Mb en RAM y 300 Mb libres en disco duro
disponibles sélo para su instalacion.

El software de instalacion puede descargarse desde su sitio oficial,
http://NSL.csi.nctu.edu.tw/nctuns.html, y una vez instalado en el equipo, se modificara el
MBR creando la opcién para el reingreso de kernel desde NCTUns. Esto se consigue
bajo la ejecucidn del archivo install.sh incluido en los instaladores, lo que a su vez creara
un directorio bajo el nombre por defecto de “nctuns” ubicado en /usr/local, y que contendra
subdirectorios como “bin,” "etc,” "tools,” "BMP,” y “1ib”. La carpeta de “bin” contendra
los programas ejecutables de la interfaz grafica de usuario, dispatcher, coordinator, y los
motores de simulacion, denominados nctunsclient, dispatcher, coordinator y nctunsse
respectivamente. En “tools” se alojaran los ejecutables de varias aplicaciones vy
herramientas para la configuracion de los dispositivos que soporta el simulador. El
directorio de “etc” contiene los archivos de configuracion necesarios por el programa de
GUI, dispatcher 'y coordinator, llamados mdf.cfg, dispatcher.cfg Yy
coordinator.cfg respectivamente. Por su parte, “BMP” contiene todos lo archivos
*.bmp utilizados por el programa de GUI y que sirven para mostrar varios iconos de
dispositivos y botones de control. Finalmente, “1ib” almacena las librerias utilizadas por
los motores de simulacion, como son protocolos e implementaciones.

Para arrancar el simulador, deben activarse los programas de dispatcher, coordinator 'y
nctunsclient, en dicho orden, por lo que antes deben configurarse la variable de
NCTUNSHOME. Para ello debe ejecutarse  “setnv NCTUNSHOME
/usr/local/nctuns” y escribir el comando ‘export
NCTUNSHOME=/usr/local/nctuns/”. A su vez, se deben cargar las librerias mediante
los comandos “setenv LD_LIBRARY_PATH /usr/local/nctuns/” y “export
LD_LIBRARY_PATH =/usr/local/nctuns/”. Ahora pueden correrse los programas
de dispatcher, coordinator y nctunsclient ubicados en /usr/local/nctuns/bin, COMO
se menciond antes, a lo cual surgira la interfaz del simulador tal como se observa en la
Figura A1.
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Figura A1. Interfaz grafica de NCTUns 3.0

Como se observa en el area resaltada de la Figura A1, los botones D, E, Ry P, se
refieren a los médulos de dibujo (Draw Topology), editor (Edit Property), arranque (Run
Simulation) y accién (Play Back), respectivamente. Sin embargo, el programa no
funcionara si se opera bajo una sesién de root, por lo que debe establecerse otra cuanta
de usuario y su respectivo pasword en Settings -> Simulation (ver Figura A2).

Entre los distintos dispositivos con los cuales se pueden realizar simulaciones se
encuentran (ver Figura A3.):

1. host, 2. hub, 3. switch, 4. router, 5. AP WLAN, 6. nodo mévil WLAN (modo ad-hoc), 7.
nodo mévil WLAN (modo infraestructura), 8. host externo 9. router externo, 10. nodo
externo movil WLAN (modo ad-hoc), 11. nodo externo mévil WLAN (modo infraestructura),
12. GGSN GPRS, 13. pseudo switch GPRS, 14. SGSN GPRS, 15. estacién base GPRS,
16. teléfono GPRS, 17. router de frontera con soporte para DiffServ, 18. router interno con
soporte para DiffServ, 19. circuito de conmutacién para redes Opticas, 20. burst switch
optico, 21. AP para redes en malla, 22. AP con STP para redes en malla, 23. switch
multipasarela para redes en malla, 24. nodo mévil 802.11e, 25. AP 802.11e.
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Figura A3. Iconos de los diferentes dispositivos soportados por NCTUns 3.0

El modo Draw Topology permite la adicién y eliminacion de nodos y/o enlaces; en el
modo Edit Property se pueden agregar las propiedades y especificaciones de cada nodo,
asi como sus aplicaciones, sin embargo, no pueden realizarse cambios en la topologia
por lo que se debe regresar al modo anterior; en el modo Run Simulation se puede
correr/pausar/continuar/detener/abortar/desconectar/reconectar una simulacion, pero para
ella debe guardarse el modelo de simulacion; por ultimo, el modo Play Back permite
observar la animacion creada una vez finalizada la simulacién, donde puede observarse el
flujo de los paquetes a lo largo de la red simulada, permitiendo cambios en la escala de
tiempo y fps (frames per second) enviados por la pantalla.



EDITOR DE TOPOLOGIAS

Contiene los cuatro modos mencionados anteriormente: Draw Topology, Edit Property,
Run Simulation y Play Back. A través del primero de ellos se pueden agregar todos los
elementos pertenecientes a cierta topologia de red, incluidos nodos como los que se
muestran en la Figura A3, asi como conexiones cableadas, trayectorias de equipos
moviles, obstaculos, incluir etiquetas, etc. Pero es mediante el modo Edit Property que
pueden configurarse los atributos de los nodos de red.

Para el caso de un host, la ventana de la Figura A4 aparecera cuando se de doble click
sobre él, en la cual podran adicionarse los comandos que dictaminen los atributos del
mismo. A través del boton “App. Usage” (ver Figura A5) se obtiene informacién sobre
las distintas aplicaciones que puede ejecutar este terminal.

Host ID I:I Name ::|
Application | Down time | Mobile IP |
iR SR Siioe o] G ) ot B v
Modify
Add RTP
Modify RTP
Delete
App. Usage
t i »
Command console MNode editor OK Cancel

Figura A4. Ventana de atributos de un host.

Para agregar una de las aplicaciones indicadas en la ventana de manual de usuario, se
presiona el boton “Add” lo cual dara lugar a la ventana indicada en la siguiente Figura A®6.
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Figura A6. Ventana de comandos de trafico.
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Una vez se agregan los nodos, el usuario puede modificar los atributos de ese nodo
haciendo doble clic sobre el icono. En particular, la herramienta de simulacion NCTUNS
en su version 3.0 trae consigo un conjunto de alternativas para generar trafico a través de
la red en cuestion. El primer paso es ingresar a la ventana de configuracion de tréfico
haciendo clic en el botén “Add”:

Su uso se basa en el ingreso de un comando o programa de aplicaciéon en el campo
“Command” en donde adicionalmente el usuario esta en capacidad de modificar los
tiempos de inicio y fin de la generacion de trafico. Esto se muestra en la Figura A6. Si en
algun momento el usuario desea agregar un nuevo comando, modificar o borrar uno ya

LT}

existente sélo es necesario hacer click sobre los botones “Add”, “Modify” 0 “Delete”
respectivamente.

Entre los comandos utilizados en el trabajo de grado para generar trafico se encuentran:
Comandos:
o ttcp

Sintaxis:
ttcp -t [-opciones] direccion IP host destino: Genera trafico

ttcp -r [-opciones ]: Recibe trafico

Opciones comunes a ambos comandos:

-u hace uso de UDP (por defecto TCP)

o YYY envia o recibe trafico por el puerto YYY

Opciones especificas de la opcion -r:

-w XXX.log almacena en un archivo de nombre “XXX.log” un registro del throughput por
segundo

Ejemplo 1:

ttcp -t -p 8000 1.0.1.2 : Este comando es caracteristico de una estacion que genera tréafico
encapsulado sobre TCP en el puerto 8000 con destino la estacién con direccién IP
1.0.1.2. Nétese que al no incluir la opcion -u, se genera automaticamente trafico TCP.

ttcp -r -p 8000: La estacion que contenga este comando registrara todo el trafico UDP que
reciba por el puerto 8000 proveniente de cualquier estacién.

e stg (generador de trafico), rtg (receptor de trafico)
Sintaxis:

stg -[modos] Direccion IP del destino [-opciones]
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[-modos]:

-t Duracién (seg) Genera trafico TCP con una duracion en segundos determinada por
el usuario

-u Tamanos de la carga util de datos (bytes) Duracién (seg): Se transmite
trafico UDP con una carga util dada por un tiempo especifico

-i XXX.cfg Genera tréfico de acuerdo a las caracteristicas del archivo de
configuracion XXX.cfg

[-opciones]

-pYYY Envia trafico por el puerto YYY

Formato del archivo XXX.cfg:

type: ###: Protocolo ### ya sea TCP o UDP

start_time:  ###: Tiempo ### expresado en segundos desde el cual se comienza la
transmisién del primer paquete.

on-off: ###. Numero de lineas entre la linea actual y la linea que contiene la
cadena de caracteres “end” que sera repetida ### veces.

on: [time: XXX o packet YYY] [distribucién de tiempo entre transmisiones consecutivas]
[distribucion de tamafo de paquetes]: Indica que el trafico debe ser generado basandose
en un intervalo de tiempo especifico con una determinada distribucién de tiempo y de
tamano de paquetes.

end

[time:XXX] indica que se debe generar trafico durante XXX segundos

[packet:YYY] indica que se deben generar YYY paquetes Unicamente

De las anteriores configuraciones solo se debe escoger una.

La distribucion de tiempo entre transmisiones consecutivas puede ser:

[const XXX]: indica que el tiempo que transcurre entre el envio de

paquetes consecutivos es un valor fijjo de XXX
segundos.



[uniform XXX, YYY]:

[exponential XXX, YYY, ZZZ]:

el tiempo transcurrido entre el envio de paquetes
consecutivos varia entre una valor minimo igual a
XXX segundos y un maximo igual a YYY segundos.

el tiempo de envio entre paquetes consecutivos es
una funcién exponencial con una media igual a XXX,
un valor minimo de YYY segundos y un maximo de
Z7Z7 segundos.

La distribucion del tamario del paquete puede ser:

[const XXX]:

[uniform XXX, YYY]:

[exponential XXX, YYY, ZZZ]:

off: time: ###:

Nota para trafico UDP:

indica que el tamarno de los paquetes es un valor XXX
fijo.

indica que el tamafno de los paquetes generados es
funcion de una distribucion uniforme con un valor
minimo de XXX bytes y un maximo de YYY bytes.

el tamano de los paquetes generados es funcion de
una distribucién exponencial con una media de XXX
bytes, un valor minimo de YYY bytes y un maximo de
Z77 bytes.

el generador de trafico deja de transmitir por un
periodo de ### segundos.

stg soporta cuatro tipos de distribuciones de tiempo para el trafico UDP:

(1) const XXX:

(2) uniform XXX YYY:

(3) exponential XXX YYY ZZZ:

(4) greedy: tiempo aleatorio

Tasa Constante de Bits (Constant Bit Rate, CBR) con
distribucion de tiempo de XXX segundos

Distribucion con un tiempo minimo de XXX bytes y
un maximo de YYY bytes.

Distribucion con promedio XXX, minimo YYY vy
maximo ZZZ (Flujos de paquetes con una distribucion
de Poisson)

stg soporta tres tipos de tamanos de paquetes (en bytes) para el trafico UDP:

(1) const XXX:
(2) uniform XXX YYY:
(3) exponential XXX YYY ZZZ.

constante
valor minimo XXXy maximo YYY
promedio XXX, valor minimo YYY y maximo ZZZ.

Nota: EI maximo tamafo del paquete no puede ser mayor a los 1500 bytes de la Maxima
Unidad de Transferencia (Maximun Transfer Unit, MTU) Ethernet.



Ejemplo 2:
Un ejemplo de generacion del cédec G.711" haciendo uso de la opcién.
Ejemplo.cfg
type: udp
start_time: 1
on-off: 1
on: time: 90 const 0.02 length: const 160
end
En este caso se genera ftrafico con una longitud de trama de 160 bytes con una
distribucion de tiempo de 0.02 segundos es decir 20ms (const 0.02) por un tiempo de 90
segundos (time) a partir del primer segundo de haber iniciado la simulacién (start_time).
Es asi como el comando stg -i Ejemplo.cfg -p 5004 1.0.1.5 envia trafico por el puerto 5004
hacia la estacion con direccién IP 1.0.1.5 de acuerdo a la configuracién especificada en el
archivo ejemplo.cfg

* rig

Sintaxis:

rtg [-tipo] [-opciones]

[-tipo] -t Conexién TCP
-u Conexién UDP
[-opciones]
-p ### La estacion escucha por el puerto numero ### (por defecto 3000)

-0 XXX.log  Reqgistra estadisticas de delay y pérdida de paquetes en un archivo de
nombre XXX.log.

-w YYY.log Registra el throughput en un archivo de nombre YYY.log

Ejemplo 3:

rtg -u -w archivo1.log -o archivo2.log

En este caso la estacidbn receptora generara archivos con nombres archivol.log
archivo2.log que contendran las estadisticas relacionadas con el trafico UDP entrante por
cualquier puerto (no se ha especificado el nUmero del puerto).

e stcp, rtcp

! Cédec con carga Util de 160 bytes y tamafo de muestra de 20 ms.
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Sintaxis:

stcp -p ### Direccion IP destino : Generador de trafico

ricp -p ###: Receptor de tréfico.

En donde -p ### es el numero del puerto por donde en envia o recibe informacion.

De manera similar pueden editarse tanto hubs, switch, router, AP y WANs (ver Figuras
A7, A8, A9, A10 y A11 respectivamente).

Para el caso de estaciones inalambricas, estas cuentan con la opcion de trabajar tanto en
modo ad-hoc, en el cual es posible ingresar instrucciones de trayecto; como en modo
infraestructura, en el que puede asignarse direcciones IP, asi como la creacion de
subredes, etc. Y en ambos casos pueden agregarse obstaculos para el estudio de
entornos indoor, por ejemplo, en los cuales pueda evaluarse la implicacién de los mismos
(ver Figura A12).
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Figura A7. Ventana de atributos de un hub
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Figura A8. Ventana de atributos de un switch.
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Figura A9. Ventana de atributos de un router.
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Figura A12. Topologia ad-hoc con obstaculo de por medio.

A semejanza de los dispositivos como host, switches, etc., los nodos inalambricos IEEE
802.11e también presentan una interfaz de configuracion de atributos, y al entrar en su
“Node Editor” se podra observar la constitucion de este nodo, en especial los modulos
avanzados 802.11e tanto en las estaciones y APs que funcionen bajo este tipo de
tecnologia (ver Figuras A13, A14 y A15).
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Figura A13. Ventana de atributos de una estacion movil.

Que mejor manera para observar el comportamiento de esta herramienta de simulacién
gue mediante un ejemplo. Por ello, a continuacién se expondra paso a paso la simulacion
de una pequefa red inalambrica que soporte QoS en la que se evalue la funcién de
acceso al medio EDCA.

La topologia que se utiliza se indica en la Figura A16 en la que aparece resaltados el
icono que permite las conexiones cableadas entre los dispositivos que asi lo requieran y
enfatiza el modo Draw Topology bajo el cual se realiza la insercibn de nodos y
conexiones como se menciond anteriormente.
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NCTUns 2.0 verion (3/1/2006):
File Edit Tools Setting Simulation View Help
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Figura A16. Topologia de red.

Cada vez que se inserta un terminal inaldambrico 802.11e debe establecerse su prioridad
(ver Figura A17). Para este caso los nodos 6, 7, 8 y 9 tendran prioridad 1, 3, 5y 7
respectivamente. Como se sabe, las prioridades de estos tipos de terminales varian de 0
a 7 representando el tipo de trafico del cual se trata segun se indica en la Tabla A1:

Tabla A1. Tipos de trafico segun 802.1p

UP
P (Same as 802.1D § Designation
Priority 802.1D user designation AC (informative)
priority)
Lowest 1 BK AC BK Background
2 — AC BK Background
0 BE AC BE Best Effort
3 EE AC BE Best Effort
4 CL AC_ VI Video
Highest -
5 VI AC VI Video
6 VO AC_VO Voice
7 NC AC_VO Voice
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Figura A17. Prioridad QoS de terminales 802.11e.

Como dato adicional cabe mencionar que para el caso en el que el nimero de nodos a
agregar resulte demasiado grande, este simulador, bajo su modo Draw Topology ofrece
la opcion de crear matrices de nodos, asi como la ubicacién de nodos en posiciones
aleatorias, a través del comando® Tools -> 802.11(e) Mobile Nodes -> Insert
802.11(e) Mobile Nodes a lo cual aparecera una ventana donde puede configurarse
la dimensidn de la matriz de nodos a ser insertada y especificarse el espaciamiento entre
las estaciones que la conforman (ver Figura A18). A modo de ejemplo, para la creacion
de una matriz de nodos con dimensiones 3x4, con un espaciamiento entre nodos de 50 m,
el resultado seria el mostrado en la Figura A19.

Volviendo al ejemplo original, para pasar al modo Edit Property se debe guardar el
archivo de simulacién tal como se aprecia en la Figura A20.

Luego, se va al menl Edit -> Select All 802.11(e) Mobile Nodes para
seleccionar todos los nodos 802.11e y asignar direcciones IP a los mismos a través del
mend Tools —-> 802.11(e) Mobile Nodes -> Generate 802.11(e) Mobile
Nodes'’IP and MAC Address (Need to select some Duch nodes in the
Edit Property). Ahora pueden agregarse los comandos pertinentes de cada nodo por
lo que se da doble click sobre el dispositivo de interés, dando a su paso la apariciéon de
una nueva ventana donde podrd modificarse su configuracion.

2 @ . e
Si se desea agregar nodos 802.11 ya sea en modo infraestructura o ad-hoc, el comando a utilizar es Tools -> WLAN
Mobile Nodes —-> Insert WLAN Mobile Nodes.
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Figura A18. Insercion de multiples nodos.
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Figura A19. Matriz de 3x4 nodos.
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B NCTUns 3.0 verion (3/1/2006): ==
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Figura A20. Modo Edit Property.

La Figura A21 senala en la pestafia de “Aplicattions” sobre el botén “Add”el comando
“ttcp —t —u —s —p 8000 1.0.1.71” asignado al nodo 6, donde la direccioén IP al final del
comando corresponde a la del nodo 1. Asi mismo, se configura a los nodos 8, 9y 10 con
las direcciones IP de los nodos 2, 3 y 4 respectivamente. Con “ttco —f’ se indica al
simulador que tales nodos tendran la tarea de emitir paquetes hacia las direcciones IP
sefaladas a través de los puertos indicados con “-p # de puerto”. Para mayor informacién
se puede remitir al botdén “App. Usage” el cual contiene el significado de los comandos y
su apropiado uso.

Para los nodos 1, 2, 3 y 4 se realiza de manera similar, s6lo que estos seran configurados
de modo que reciban la informacion que fue enviada hacia ellos (“ttcp -r’) y por el nimero
de puerto asignado (“-p # de puerto”), tal como se muestra en la Figura A22.

Luego se pasa la modo de Run Simulation por lo quede irse al mend Simulation ->
Run (ver Figura A23).

Finalmente, en el modo Play Back puede observarse la animacion creada como resultado
de la simulacién donde podra observase de hecho que aquel nodo con categoria mas alta
ganara el acceso al medio, tal como lo estipula EDCA, mientras que las demas estaciones
se veran obligadas a retrasar sus trasmisiones (ver Figura A24).

Para descargar éste, y otros simuladores como NS-2 y Opnet IT Academic Guru Edition,
remitase a [2], [3] y [4].
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Figura A21. Insercion de comandos en los nodos inalambricos de red.

[ NCTUns 2.0 verion (3/1/2006): /usr/local/nctuns/bin/demo/Demo32_11eEDCA/DemoR2_11eEDCA. tpl =[S
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Please note that the starting time for a server
program should be set to a time that is earlier
than the starting time set for a client program.
Otherwise, the client cannot connet to the server
immediately and its TCP connection may
unnecessarily timeouts. For example, if you

let ricp (server) start at time 0 second,

it is better to let stcp (client) start at time 0.1

[+ | second.
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Figura A22. Insercion de comandos en los nodos cableados de red.
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11eEDCA/Demo32_11eEDCA.1pl
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Figura A23. Simulacion de la topologia de red.

NCTUns 3.0 verion (3/1/2006): fusr/local/nctuns/bin/demo/Demo32_11sEDCA/Demo32_11sEDCA.tpl
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Figura A24. Resultados vistos mediante el Play Back de NCTUns 3.0
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